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Preface

Welcome to the Developer's Guide for Oracle [Developer Extensions.

Audience

This document is intended for developers that develop use Oracle JDeveloper
extensions.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are
hearing impaired.

Related Documents

Oracle Fusion Middleware Installation Guide for Oracle [Developer
Oracle Fusion Middleware User Guide for Oracle [Developer

Oracle Fusion Middleware Fusion Developer's Guide for Oracle Application Development
Framework

Oracle Fusion Middleware Web User Interface Developer’s Guide for Oracle Application
Development Framework

Oracle Fusion Middleware Java EE Developer’s Guide for Oracle Application
Development Framework

Oracle [Developer 11g Online Help

Oracle [Developer 11g Release Notes, link included with your Oracle JDeveloper 11g
installation, and on Oracle Technology Network



Conventions

The following text conventions are used in this document:

Convention

Meaning

boldface

italic

monospace

Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.




What's New in This Guide in Release
11.1.2.2.0

For Release 11.1.2.2.0 the Oracle Fusion Middleware Developer’s Guide for Oracle
JDeveloper Extensions replaces the non-context sensitive online help that was available
in previous releases of Oracle JDeveloper.

For changes made to Oracle JDeveloper and Oracle ADF for this release, see the
What's New page on the Oracle Technology Network at
http://www.oracle.com/technetwork/developer-tools/jdev/documenta
tion/index.html.

xi



Xii



1

Introduction to Developing Oracle
JDeveloper Extensions

This chapter is designed to get you up and running quickly using Oracle JDeveloper to
develop extensions to the JDeveloper integrated development environment (IDE).

The following sections provide an overview of using and developing JDeveloper
extensions:

= Section 1.1, "About Developing Oracle JDeveloper Extensions"
= Section 1.2, "Developing Extensions with OSGi"

ms  Section 1.3, "How JDeveloper Extensions Work"

= Section 1.5, "Migrating Extensions from Previous Releases"

= Section 1.6, "Getting Started With Extension Development"

= Section 1.7, "Working with the Extension Manifest"

= Section 1.8, "Working with the OSGi Manifest"

1.1 About Developing Oracle JDeveloper Extensions

Oracle JDeveloper is an integrated development environment (IDE) for building
applications using the latest standards for Java, XML, Web services, and SQL. Most of
the basic functionality in JDeveloper is implemented as extensions—software packages
which add features and capabilities to the basic JDeveloper IDE. You can add existing
extensions into JDeveloper, or you can build on JDeveloper’s native functionality by
creating extensions to provide new features tailored to your organization’s
development requirements, for example:

s To streamline your work flow.
= To use a third-party team development tool.
= To use software packages unique to your team.

s To help implement development standards and best practices with audit
extensions.

There are a wide variety of extensions readily available for you to download and use.
Some of these have been developed by Oracle, and some by third parties. These
provide new features to JDeveloper and integrate it with other applications that are
used by customers in their own development environments. For example, many of the
version control and teamworking systems available in JDeveloper are written and
distributed as extensions. The open architecture of JDeveloper means that you can
download and install them from Check for Updates on the JDeveloper Help menu.
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Alternatively, you can install them from the Oracle JDeveloper Extensions page on the
Oracle Technology Network (OTN) at
http://www.oracle.com/technetwork/developer-tools/jdev/index-099
997 .html.

Note: The recommended way of installing extensions to JDeveloper
is to use Check for Updates on the JDeveloper Help menu because
only extension versions that match the version of JDeveloper you are
using will be available.

For more information, see "Working with Extensions" in Oracle Fusion Middleware User
Guide for Oracle [Developer.

This same open architecture also makes it possible for you to write your own
extensions if you have specific needs or you would like to integrate JDeveloper with
some external process or tool that your development team uses. You can add menu
items, create context menus, integrate features into the JDeveloper toolbar, create
dockable windows that provide a view into your data objects, and more.

Note: The way that JDeveloper handles extensions has changed in
Oracle JDeveloper 11.1.2.nn. For information about extensions for
earlier versions of JDeveloper, see the online help in your version of
JDeveloper.

Oracle extensions for earlier versions of JDeveloper, including the
Extension SDK, and third-party extensions for earlier versions of
JDeveloper are available from the Oracle JDeveloper Extensions page
at
http://www.oracle.com/technetwork/developer-tools/jd
ev/index-099997 . html.

Information about migrating extensions written for earlier versions of
JDeveloper is in Section 1.5, "Migrating Extensions from Previous
Releases."

You can use JDeveloper’s native features to develop your own extensions. For more
information, see Chapter 2, "Developing Extensions in Oracle JDeveloper."

For more advanced development, the JDeveloper Extension Software Development Kit
(Extension SDK) has been developed by the JDeveloper development team. It includes
a collection of projects containing sample code, and the javadoc-generated
documentation for the Extension SDK API which provides reference for classes and
other features used in extension development. It is available from Check for Updates
on the JDeveloper Help menu, and it contains much more complete documentation
and examples. If you are planning to do serious extension development, either to
provide wide support to an internal team or to develop an extension as part of a
product or third-party application to pass on to your own customers, it is highly
recommended that you download the Extension SDK. For more information, see
Chapter 3, "Developing with the Extension SDK."

You can use the Oracle JDeveloper page on the OTN forum to ask a question about
developing an extension, contribute to a discussion, or interact with other users. The
Oracle JDeveloper page on the OTN forum is located at
http://forums.oracle.com/forums/forum. jspa?forumID=83.
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In contrast to the Extension SDK, JDeveloper also allows you to use external tools
without any coding;:

»  You can invoke command line interfaces
= You can pass parameters
= You can add menus to JDeveloper

For more information about External Tools, see "Adding External Tools to JDeveloper"
in Oracle Fusion Middleware User Guide for Oracle [Developer.

1.2 Developing Extensions with OSGi

The Open Services Gateway Initiative (OSGi) is a specification for building service
platforms running on top of a Java Runtime environment. JDeveloper is built as a set
of extensions which conform to OSGi, and any extensions that you write must also
conform to this standard.

For more information about OSGi, see the OSGi Service Platform Core Specification
Release 4, Version 4.2 which is available from http: //www.osgi.org.

The OSGi Framework can be divided into two main elements, both described below:

= Service/Component Platform, that is the service providers, service requesters, and
service registry.

= Deployment Infrastructure, that is the service bundles which contain
implementation classes, resources, bundle metadata, and manifest file.

1.2.1 Service/Component Platform

The Service/Component Platform allows an OSGi implementation to activate,
de-activate, update and de-install existing services and to install new services
dynamically.

The Service/Component platform supports the interaction between 3 actors:

1. Service providers, which provide specific services and publish service
descriptions.

2. Service requesters, which discover services and bind to the service providers.

3. Service registry, which manages the publication and discovery of services based
on the registered service descriptions.

An OSGi service is a Java class or interface (service interface), along with a variable
number of attributes (service properties), which are name and value pairs. Service
properties allow differentiation between service providers which use the same service
interface.

The service registry allows services to be discovered by service requesters using LDAP.

Service requesters can receive events signalling changes, for example, publication or
retrieval of a service in the service registry, using notification mechanisms.

1.2.2 Deployment Infrastructure

Services are packaged into service bundles which contain service implementation
classes and resources, along with the manifest file manifest .mf which contains the
bundle metadata. The manifest file contains information such as the service name,
version and dependencies.
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Service providers and service requesters are part of a service bundle that is both a
logical and a physical entity. The bundle is responsible for run-time service
dependency management activities which include:

Publication
Discovery
Binding

Adapting to changes resulting from the dynamic availability—the arrival or
departure—of services that are bound to the bundle.

When you create an extension in JDeveloper, it is composed into an OSGi service
bundle.

1.3 How JDeveloper Extensions Work

This section describes the essential features of how extensions work in JDeveloper. In
order to help with startup performance, overall memory use, and how JDeveloper
performs day to day, only extensions that the user is using are loaded. Some terms and
concepts that you may be unfamiliar with are described below:

JDeveloper users choose a role in which to work, and the role determines which
JDeveloper extensions are loaded because roles list the set of possible extensions
for that role. For example, the JDeveloper default role lists all extensions in the
Studio Edition.

Initialization is an operation that involves calling the extension initialization code
Addin.initialize (). Extension initialization gives the extension an
opportunity to initialize whatever it needs to function properly at the moment the
end user is about to exercise that extension's functionality.

The initialization list is a list of extensions previously initialized. These same
extensions are initialized when the user reopens a project recording this list.

Trigger hooks are a set of declarative integration hooks that provide the
mechanism to trigger extension initialization. They are defined in the
<trigger-hooks> section of the extension manifest extension.xml, and they
are processed when JDeveloper starts, even though your extension may not have
been initialized.

So, any information the JDeveloper IDE needs about your extension at startup,
such as the gallery items it contributes, or the Java libraries it defines, or the node
recognizers it defines, must be provided in trigger hooks.

By contrast, the <hooks> section of the extension manifest is processed later when
your extension is initialized.

Registration is an operation that involves reading and caching the trigger hooks
section of the extension manifest.

Lazy initialization is the term for extensions not being initialized until their trigger
hook is activated.

Extension versioning is managed by OSGi. Two or more versions of the same
extension can be loaded at the same time, and if an extension is activated all
dependent extensions are also loaded. OSGi handles the situation of an extension
depending on a certain version or range of versions.

Extensions are classloaded in their own classloader. The extension lists the set of
packages that it exports to other extensions. The OSGi bundle manifest file defines
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the Java packages that are made available to other bundles. Access to the restricted
classes is not possible, even using reflection, since OSGi protects them by means of
the extension's Java classloader.

s The OSGi service infrastructure dynamically manages service providers and
requesters.

= Extensions can have dependencies on other extensions. When an extension is
loaded, any other extension marked as a dependency in the OSGi bundle manifest
is also loaded. You may have already experienced this in JDeveloper, when you
have to click Load Feature, for example, in the Application Properties, Project
Properties, or Preferences dialog to start up a feature that you have not accessed
before, and have to wait while the relevant extensions load.

= JDeveloper extensions conform to the JSR 198 specification, which provides a
standard extension API for IDEs. For more information, see
http://jcp.org/en/jsr/detail?id=198.

1.3.1 How Extensions are Processed

There are two distinct phases to the way that JDeveloper processes extensions:

= Extension registration. This happens as JDeveloper starts up. It involves
registering all extensions available for the selected role. No extension code is
executed except for those extensions required to start JDeveloper.

= Extension initialization. This happens at any time the user accesses a functional
area registered by an extension during the extension registration phase. Therefore
you can see that an extension can be initialized at any time when JDeveloper is
being used.

1.3.2 Registering Extensions and Using Trigger Hooks

Extension registration is the JDeveloper IDE startup phase during which the extension
registry processes the <trigger hooks> section of the extension manifest
extension.xml from all extensions available. During this processing no
extension-specific code is executed with the exception of translatable resources such as
Java resource bundles.

Extensions can define extension specific trigger hooks using the <trigger-hook>
integration hook. If they do so, they must use the
oracle.ide.extension.HashStructureHook handler since the IDE will not
execute extension specific code unless that extension is initialized. The extension
specific trigger hook data will be available for retrieval in the Extension Registry. The
extension owning the trigger hook can retrieve that data once that extension is
initialized. For more information, see Section 2.5.1, "How to Register a
<trigger-hook-handler>."

By contrast, other items that do not belong in the <trigger hooks> section of the
extension manifest extension.xml are initialized declaratively in the initialization
phase of the extension.

There are two types of trigger hooks, system and custom, and every extension is
initialized by:

= Being called from a system trigger hook
= Being called from a custom trigger hook

= Being explicitly initialized by another, already initialized, extension
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The types of trigger hook defined by the JDeveloper IDE are:

Menus: Only menus that qualify as an entry point to an extension should be menu
trigger hooks, and menus that are used to support an already initialized extension
should not be trigger hooks. For example, in the JDeveloper View menu, the
Breakpoints menu item is a trigger hook since a user will want to set breakpoints
before running the debugger, but the debugger subMenu in the View menu is not
a trigger hook since everything in it is only used once the extension is initialized.
From this you can see that menu items for uninitialized extensions are not visible
in JDeveloper.

Context Menus: Extensions can create custom trigger hooks that use context
menus as the trigger. There are no system-level context menu trigger hooks.

IDE Actions and Controllers: Only actions and controllers to support menu
trigger hooks should be registered. All other actions and controllers should
execute in the initialization phase. Any controller registered for a trigger hook
menu will not be able to run code to determine if their menu is disabled or not; it
must use declarative controller logic to specify when the menu is shown.

Gallery Items: Extensions can list items in the JDeveloper New Gallery using the
gallery item trigger hook. When the user opens a dialog or wizard from the New
Gallery it causes the extensions for that item to initialize, and any extension
marked as a dependency in the OSGi bundle manifest of this extension is also
loaded.

Technology Scopes: When a technology scope is added to a project, the extension
that registered that technology scope is initialized, along with any other extension
marked as a dependency in the OSGi bundle manifest.

NodeFactory Recognizers: This allows extensions to identify the nodes they own.
When a node becomes visible in a navigator, if the extension for that node is
registered, it will be initialized. NodeFactory recognizers also handle things like
dragging a file from the desktop into JDeveloper.

IDE Preferences/Settings, Application Preferences/Settings, Project
Preferences/Settings: Uninitialized extensions will only show as a category listing
in the Preferences dialog (available from the Tools menu). It is not until a user
clicks on the category that they will be asked if they want to initialize the
extension at that point.

Singleton Registration: Singleton classes register as a trigger hook. When a client
requests a service from a singleton, the framework will check to see if that
singleton's extension has been initialized. If it has not, it will call for the extension
to be initialized. An example is the Log Manager.

Annotations: Extensions can register themselves as needing an annotation trigger
hook. They list out the annotation class names and when the user types one of
those annotations, we will initialize that extension at that time. The annotation
trigger hooks are used during navigator node expansion to determine icon
overlays. When a parent node is expanded, the framework will look for any
annotations that are registered and if found, will supply the appropriate icon for
that node. The extension will not be initialized in the case where the node icon
overlay is applied.

Application and project migrators: These migrators must be defined
declaratively. Migrators specify the current versions supported. If the application
or project file lists an older version of the migrator, or no version at all, JDeveloper
triggers the initialization of the extension in order to perform the migration of that
extension's data.
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Library and Tag Library: When a library or tag library is added to a project, the
associated extension will trigger to initialize. In addition to this, when a project is
opened (not loaded), JDeveloper looks for libraries of that project and
automatically loads the extensions that are associated with that library or tag
library if they are not already loaded.

Custom Trigger Hooks: An extension can define its own trigger hook. This is
useful for the situation that an extension wants to allow clients to plug into it. An
extension defines its trigger hook in the same manner that it defines a regular
hook. Client extensions can then add a trigger hook registration (either system or
custom) into their extension manifest. When registering a trigger hook, the
extension specifies which extension(s) need to be loaded in order for the trigger to
take effect. These are called hook dependencies. JDeveloper ensures that this hook
is only processed when all the extensions listed as hook dependencies are
initialized.

1.3.3 How Lazy Initialization Works

In order to avoid initializing all extensions every time JDeveloper starts lazy extension
initialization is used.

During JDeveloper startup, the IDE only executes Addin.initialize () code if
the extension that owns the Addin has been previously used by the end user in the
currently opened application or project. For more information, see Section 2.2.4,
"Understanding Node Recognizers."

Each extension identifies a type associated with their trigger hook so that this
hook:

— Can only be triggered when there is an application workspace open.
— Can only be triggered when there is a project open.

— Canbe initialized at any time in the way that, for example, the HTTP Analyzer
can be.

As users work on an application in JDeveloper, the user's usage of extension
functionality is recorded in a project-specific extension initialization list. That way,
when the user stops working on a project by exiting JDeveloper and re-starting at
a later time, JDeveloper only initializes the extensions listed in the project's
initialization list.

For extensions that do not require a project, the information is stored in the IDE
preferences for the user.

When you are developing your extension you need to consider how the integration
points deal with lazy initialization. For example:

Extensions cannot assume that integration points are static; extensions must be
ready at any time during their life cycle to process and integrate new data
associated with their integration point.

For example, extension A has an API or a custom extension hook that allows other
extensions to register some listener class. Extension A cannot assume that all such
listeners are registered by the time extension A is initialized; other extensions that
depend on A can be lazy initialized later in the life cycle of ABC. Therefore,
extension A must update its event firing code associated with these listeners to
deal with this effect of extension lazy loading. The way this is done is described in
the next point.
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Extensions should use oracle.ide.extension.HashStructureHook to
implement custom integration hooks. This hook processing class has a property
change listener mechanism that lets clients know when new additional data is
registered. Your extension should listen for these property change events.

You should avoid having a deep dependency tree because having extensions with
deep dependency trees, What will happen is that the extension will cause the
initialization of all the extensions it depends on, which can diminish the
performance gains of lazy extension loading. If you find that your extension has a
deep dependency tree, you need to refactor the extensions to reduce the number of
extensions it depends on. For more information, see Section 2.2.6, "Understanding
Large Extensions."

1.4 Guidelines for Writing JDeveloper Extensions

This section is an outline of good development practice for JDeveloper extensions.

Write declarative trigger hooks to initialize the model of your extension and
declare them in the extension manifest. Extension initialization code happens in
the OSGi activator, and the first time that a class is classloaded from an extension,
OSGi automatically activates the bundle by calling its activator.

You can find more information to guide you in Section 2.2, "Use Cases for Developing
Extensions."

1.5 Migrating Extensions from Previous Releases

If you have an extension that you developed for an earlier version of JDeveloper, you
will need to change it to run in the current release of JDeveloper. Section Section 1.3,
"How JDeveloper Extensions Work" describes how extensions now work in
JDeveloper, so you should start by being familiar with the concepts described there.

The coding areas you need to consider are:

The Addin. initialize method is no longer called at IDE startup. You must
initialize your extension using a trigger hook.Trigger hooks are defined in the
extension manifest extension.xml, and you can use one of the trigger hooks types
defined by the JDeveloper IDE, or create a custom trigger hook. For more
information, see Section 2.5, "How to Define and Use Trigger Hooks."

Almost all <hooks> properties in the extension manifest extension.xml should
now be placed in <trigger hooks>.

In earlier versions of JDeveloper, role files were exclusionary, meaning that by
default all extensions were loaded and the role file told JDeveloper what not to
load. Now role files are inclusive; only extensions listed in a role are able to be
loaded when their trigger hook is activated.

All extensions have separate classloaders. As a result, code that calls
package-protected methods from classes in the same package but different
extensions will not work.

If your extension has custom integration points, these must be changed to handle
on-demand extension initialization. For more information, see Section 1.3.3, "How
Lazy Initialization Works."

Code that uses reflection to instantiate classes in an extension that it does not have
explicit dependencies on will not work.
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There are a number of use cases in Section 2.2, "Use Cases for Developing Extensions"
that describe situations you may encounter when you are converting your extensions
to use declarative trigger hooks support lazy initialization.

1.6 Getting Started With Extension Development

Whether you use the native features of JDeveloper to create an extension, described in
Chapter 2, "Developing Extensions in Oracle JDeveloper,” or download the Extension
SDK to develop an extension, described in Chapter 3, "Developing with the Extension
SDK," you start by creating an application in JDeveloper along with one or more
projects configured for extension development.

1.6.1 How to Create an Application and Project for Extension Development

An application is the control structure for one or more projects. A project is a logical
container for a set of files that defines a program or part of a program. For more
information, see "About Working with Applications and Projects" in Oracle Fusion
Middleware User Guide for Oracle | Developer.

To create an application and project:

1.
2.
3.

Open the New Gallery by choosing File > New.
In the New Gallery, in the Categories tree, under General select Applications.

In the Items list, double-click Custom Application. The Create Custom
Application wizard opens. For help with the wizard, press F1 or click Help.

Enter a name for the application and choose a location and an application package
prefix and click Finish.

The application is created with a default project called Project1 that you will not
use and can delete.

Next, create a project that is configured for extension development. Open the New
Gallery by choosing File > New.

In the New Gallery, in the Categories tree, under Client Tier select Extension
Development.

In the Items list, double-click Extension Project. The Create Extension Project
dialog opens. For help with the dialog, press F1 or click Help.

Enter a name and other details for the extension project. When you are done, click
Finish.

The extension project is created in the Application Navigator, and contains the
elements shown inFigure 1-1.

Figure 1-1 Extension Project in the Application Navigator
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The extension project is created, along with a copy of the extension manifest
extension.xml and the OSGi manifest manifest .mf. The extension manifest is
opened in the overview editor.

1.6.2 How to Develop for a Different JDeveloper Version

If you are developing an extension for a different version of JDeveloper, you choose
the platform when you create the Extension project.

Note: You can only develop extensions for other versions of
JDeveloper 11.1.2.0.0.

When you create the extension project, as in Section 1.6.1, "How to Create an
Application and Project for Extension Development", when you have the Create
Extension Project dialog open (step 7), click Manage to open the Manage Extension
Platforms dialog.

In this dialog, enter details of the JDeveloper version that you are developing the
extension for. For more help, press F1 or click Help in the dialog.

1.6.3 How to Create an Empty Extension Project

If you are familiar with creating extensions, and want to start with an empty project,
you can create a custom application with a project that is set up for extension
development but which does not contain the extension manifest extension.xml and
the OSGi manifest manifest.mf.

To create an extension application with an empty project:
1. Open the New Gallery by choosing File > New.

2. Inthe New Gallery, in the Categories tree, under General select Applications.

3. In the Items list, double-click Custom Application. The Create Custom
Application wizard opens. For help with the wizard, press F1 or click Help.

4. Enter a name for the application and choose a location and an application package
prefix.

5. Click Next, and enter a name for the project. On the Project Features tab, select
Extension Design Time and shuttle it to the Selected list, then click Finish.

In this case, an empty project is created in the Application Navigator, and you need to
create extension.xml separately in the same way that you would create any XML file.
For more information, see "Creating XML Files in Oracle JDeveloper" in Oracle Fusion
Middleware User Guide for Oracle JDeveloper.

1.6.4 Next Steps

Once you have created an application and project you can begin to develop the
extension:

= To continue by using the JDeveloper IDE to develop, for example, by creating an
extension Addin, see Section 2, "Developing Extensions in Oracle JDeveloper."

= To use the samples in the Extension SDK to create your extension, or to use the
Extension SDK AP], see Section 3, "Developing with the Extension SDK."
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1.7 Working with the Extension Manifest

The extension manifest, extension.xml, controls many aspects of the extension.
Before you can deploy an extension, you must complete extension.xml to, for
example, register trigger hooks. There can only be one extension.xml per project,
and it must always be in a directory called meta-inf.

The extension manifest conforms to the JSR-198 specification, which is available at
http://jcp.org/aboutJava/communityprocess/final/jsr198/index.htm
1.

Hooks and trigger-hooks are set in the relevant sections of the extension manifest. The
<hooks> section of extension.xml is processed when the extension is initialized. The
<trigger-hooks> section is processed when JDeveloper starts up.

JDeveloper has a dedicated overview editor for extension.xml, illustrated in
Figure 1-2.

Figure 1-2 extension.xml in Overview Editor
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You edit extension.xml using the overview editor, where you enter information
such as details about dependencies into fields, and choose from lists of available
objects, and where you can use the Structure window and Property Inspector. To edit
information in extension.xml that is not available in the overview editor, you can
either use the Structure window or work in the extension.xml source, which you
access by clicking the Source tab.

For more information about dependencies, see Section 1.8.1, "Understanding
Dependencies."

The template code for extension.xml created by creating an extension project
contains placeholders for the main elements, shown in Example 1-1.

Example 1-1 Template Code in extension.xml

<extension id="yourcompany.extension" version="1.0" esdk-version="1.0"
rsbundle-class="yourcompany.extension.Res"
xmlns="http://jcp.org/jsr/198/extension-manifest">
<name>$ { EXTENSION_NAME}</name>
<trigger-hooks xmlns="http://xmlns.oracle.com/ide/extension">

<!-- TODO Declare triggering functionality provided by extension:
yourcompany .extension -->
<triggers/>
</trigger-hooks>
<hooks>
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<!-- TODO Declare functionality provided by extension: yourcompany.extension
-—=>
</hooks>
</extension>

1.7.1 Editing the Extension Manifest in the Overview Editor

On the General tab of the overview editor for extension.xml you enter information
about the extension such as the extension name, the SDK version, and specify features
such as an icon and copyright information. This information populates the
feature-hook and platform-info elements.

The Dependencies tab is where you can specify that this extension is part of another
extension, or alternatively specify that this extension is parent to another extension.
This populates the dependencies element. The Hooks tab is where you details of
additional extensions to contribute functionality to your extension. For more
information, see Section 1.8.1, "Understanding Dependencies."

Detailed help, which describes the content of each field, is available by pressing F1
from any tab in the overview editor.

1.7.2 Editing the Extension Manifest in the Source Editor

You edit the extension manifest in the source editor using the XML editor, a
specialized schema-driven editor which includes a number of editing features
including Code Insight and XML validation. For more information, see "Using the
XML Editors" in Oracle Fusion Middleware User Guide for Oracle [Developer.

1.8 Working with the OSGi Manifest

The OSGi manifest, manifest .m£, lists the packages that the extension bundle
exports. There can only be one manifest .mf per project, and it must always be in a
directory called meta-inf.

When a new extension project is created, a default manifest .mf is created, as shown
in Example 1-2.

Example 1-2 Default of manifest.mf

Manifest-Version: 1.0
Bundle-ClassPath: .

For detailed information about the content of the OSGi manifest, see
http://www.osgi.org/javadoc/rdv4d2/overview-summary.html.

As part of the packaging process for an extension, JDeveloper updates manifest .mf
to provide:

= Required-Bundle: Classes from another OSGi bundle that are required by your
extension are listed. Comes from the required-bundles elements in the
extension manifest.

= Export-Package: When you want to make Java packages in your extension
available to other extensions, these packages are listed.

= Bundle-Classpath: If your extension needs to reference classes from a JAR which
is not an OSGi bundle it is listed. Comes from <dependencies> elements in the
extension manifest.
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These values are set in the OSGi Bundle Profile dialog. For more information, see
Section 5.2.1, "How to Create the Deployment Profile."

1.8.1 Understanding Dependencies

Extensions can depend on other extensions or JAR files. When you are developing
extensions for JDeveloper, you need to understand the dependencies upon the
extension, as well as the extension tree. You need to know the dependencies between
your extension and other extensions, that is whether:

= Your extension is part of another extension
s Or, one or more extensions are part of your extension

You also need to know the libraries and JAR files that need to be added. For example,
if you add a dependency on oracle.jdeveloper.maven. jar, you must also add
dependency libraries for those JAR files delivered with the external Maven module.

Once you have worked this out, you set dependencies in the extension manifest, and
ensure that any libraries and additional JAR files are part of the extension bundle.

1.8.1.1 How to Set Dependencies in the Extension Manifest

When you create an extension project, the extension manifest is created and opened in
the overview editor. For more information, see Section 1.7, "Working with the
Extension Manifest."

The order in which extensions are loaded depends on the entries in the extension
manifest.

To set dependencies in the Extension Manifest:

1. Innecessary, open extension.xml in the overview editor by double-clicking on
extension.xml under META-INF in the Application Navigator. Select the
Dependencies tab.

2. To specify that other extensions are dependent on this extension, click Add
Extension Import. In the Select Extension dialog, choose one or more extensions
and click OK.

For more help at any time, press F1 or click Help from the dialog.

The extensions you select as listed as <import> elements in the
<dependencies> section of the extension manifest.

3. To specify extension requires classes from another OSGi bundle, click Add Bundle
Entry. In the Select Required Bundles dialog, choose one or more bundles that
depend on this extension and click OK.

The extensions you select as listed as <bundle> elements in the
<required-bundles> section of the extension manifest. When searching for a
class, OSGi will search in the order they are listed, so be sure to add the bundle to
the proper location in the list of bundles.

1.8.1.2 How to Set Dependencies in the OSGi Bundle Profile

As part of packaging up your extension, you create an OSGi bundle profile which is
used to determine the generated bundle manifest. For more information, see
Section 5.2.1, "How to Create the Deployment Profile."

The important entries to make on the OSGi Bundle Profile dialog are:
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= Package Exports: This is where you specify file groups that are contributors to the
Export-Package section of the generated bundle manifest. For example, if there are
Java packages in your extension which you want to make accessible to other
extensions, list the packages in this section.

= Package Imports: This is where you specify file groups, library dependencies, and
profile dependencies that are contributors to the Import-Package section of the
generated bundle manifest.

= Require Bundle: This is where you specify library dependencies and profile
dependencies that are contributors to the Require-Bundle section of the generated
bundle manifest.

The Library Dependencies page allows you to check the library dependencies for the
bundle, and the Profile Dependencies page allows you to examine and if necessary
change dependencies on other JAR deployment profiles in the application.

1.8.1.3 Duplication Between extension.xml and manifest.mf

If you edit the OSGi manifest by hand rather than letting JDeveloper create it as part of
the Deployment process, you can enter similar information about the extension in the
extension manifest extension.xml and in the OSGi manifest manifest.mf, for example:

extension.xml manifest.mf

<dependencies> Required-Bundles

<extension-id> Bundle-SymbolicNa
me

Where there is duplication, the information in manifest .mf is used, however the
extension load order is always taken from the <dependencies> section of
extension.xml.
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Developing Extensions in Oracle JDeveloper

This chapter provides an introduction to some of the features available to JDeveloper
extension writers, developers, and users, and offers examples of several of the features
that extension developers ask about most frequently. It describes the native features of
JDeveloper that you can begin using immediately to develop features for an extension
you plan to develop.

This chapter includes the following sections:

= Section 2.1, "About Developing Extensions in Oracle JDeveloper"
»  Section 2.2, "Use Cases for Developing Extensions"

= Section 2.3, "Getting the JDeveloper Look and Feel"

»  Section 2.4, "How to Create JDeveloper Elements"

= Section 2.5, "How to Define and Use Trigger Hooks"

= Section 2.6, "How to Add Online Help Support"

= Section 2.7, "How to Add Print Support"

2.1 About Developing Extensions in Oracle JDeveloper

JDeveloper uses an open architecture that makes it possible for you to write your own
extensions, if you have specific needs or you would like to integrate JDeveloper with
some external process or tool that your development team uses. You can add menu
items, create context menus, integrate features into the JDeveloper toolbar, create
dockable windows that provide a view into your data objects, and more.

2.2 Use Cases for Developing Extensions

This section outlines a series of use cases that you may encounter when planning your
extension or if you are converting an existing extension written for an earlier version
of JDeveloper to use declarative trigger hooks and support lazy initializations. Follow
the recommendations here to create extensions that load and execute quickly.

2.2.1 Understanding Rules Based Menu Sensitivity

Extensions control menu sensitivity by setting the enabled state of the action
associated with a menu item, which is determined by one of the
oracle.ide.controller.Controllers associated with that action. Since actions
are trigger hooks, oracle.ide.controller.Controller implementations
associated with the action are not called unless the extension that owns the controller

Developing Extensions in Oracle JDeveloper 2-1



Use Cases for Developing Extensions

has been initialized. For an example of setting simple rules, see Section 2.5.4.2, "How
to Define Simple Rules."

Consider the following general situation: Menu item M1 is associated with action A1,
which in turn is associated with several controllers. These controllers, in turn, are
allowed to indicate whether they handle action A1 for the given context. The first
controller that handles the selected action sets the action's enabled state.

As a specific example, EditCopy is associated with action IdeConstants.COPY_
CMD_ID, which in turn is associated with a controller that knows how to copy text,
and another controller that knows how to copy visual objects, such as UI components.

In the past, use cases following this pattern have led to performance problems, when
menus are shown or when toolbar buttons change their enabled state as JDeveloper
changes context—for example, when the user changes the current selection, changes
the current view, or changes the current active project.

To prevent time-consuming operations in these situations, develop your extensions'
menus using rule-based action sensitivity control. Controllers are defined declaratively
in the extension manifest file. For more information, see Section 1.7, "Working with the
Extension Manifest."

Part of the controller definition specifies action update rules, which control the
action-enabled state:

= Enable "Always"

= Enable when "Active application present"

= Enable when "Active project present"”

= Enable when "Context has a node"

= Enable when "Context has a node of type X"
= Enable when "Context has selection"

= Enable when "Context has single selection"

= Enable when "Context has multiple selection"

Controller can define multiple rules, and the most specific rules must appear first in
the rule definition list.

JDeveloper analyses the controller rule-based sensitivity before the extension that
owns the controller is initialized. Once the extension is initialized, the extension's
Controller.update () method handles the action-enabled state. If no controller
does so, extension operation follows the rules as defined. The recommended way is to
have all Controller.update () methods return false so as not to interfere with
GUI responsiveness.

2.2.1.1 How to Avoid Complex Controller.update() Implementations

Controllers specify the rules that determine the enabled state of an action declaratively,
using the action-enabling rules described in Section 2.2.1, "Understanding Rules Based
Menu Sensitivity." If your menu is enabled and the user executes it, the extension can
then perform the operations needed to ensure that menu execution works properly.

Earlier implementations of Controller.update () used to execute complex and
time-consuming code in order to determine the action enabled state. The current menu
sensitivity model allows the enabled state of an action to be determined declaratively,
and reduces the time involved in choosing the appropriate action to perform.

The rules that control controller behavior are as follows.

2-2 Developer's Guide for Oracle JDeveloper Extensions



Use Cases for Developing Extensions

When the extension is initialized:

A menu is about to be shown:

If it is a rules base controller, the rule will be evaluated. If false, the menu is
grayed out by the framework. If true or not a rules-based controller, see the
next bullet point.

Controller.update () is called. If it returns true, no other controllers are
processed. The controller must set the enabled /disabled state of the action
inside the update () method.

The user selects an active action. Controller.update () is called. If it returns
true, no other controllers are processed. The controller must set the
enabled/disabled state of the action inside the update () method.

When the extension is not initialized: This is described in

A menu is about to be shown. The rule for the controller is evaluated. If false,
the menu is grayed out by the framework. If true it is activated by the
framework.

The user selects an active menu on an extension that has not been initialized:

Controller.update () is called. If update () returns false an exception
will be thrown to say that when the controller's rule is evaluated to true, the
controller’s update () method must also return true, and a log message is
displayed to remind you. If update () returns true, go to the next bullet
point.

The action will be checked to see if it is enabled /disabled. If the action is
enabled, Controller.handleEvent () will be called. If the action is
disabled, go to the next bullet point.

If the controller is a TriggerController, the framework will display a
message to the user telling them why the action cannot be performed. If it is
not a TriggerController, an exception will be thrown telling the you that
this controller needs to be a TriggerController.

Therefore if the conditions in the first or third bullet points occur, you need to
address them declaratively.
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Figure 2—1 Flow Diagram for Unitialized Extension
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2.2.2 How to Use Dynamic Menu Labels and Icons

Dynamic menu labels and icons are menu items that vary depending on which
application, project or node the user selects. From within your extension, dynamic
menu labels execute code when selected in order to modify the menu label string
and/or icon that is displayed when the user selects the menu.

2.2.2.1 How to Append the Short Name to the Menu Label

When the user selects a dynamic menu, JDeveloper appends the selected element short
label to the menu item label. You can see this in:

Run > Run myproject.jpr

In general, these menus depend on the selected application, project, node, or element.
Using the controller hook, extensions can request that JDeveloper update the label
based on the action update rules. For more information, see Section 2.2.1,
"Understanding Rules Based Menu Sensitivity."

This updates the menu label, adding the short name associated with the element
specified by the rule. This element can be an application, project, or node.

2.2.3 How to Construct Dynamic Top Menus

When constructing dynamic top level menus, such as the Source top level menu,
define them declaratively using the same trigger hooks as top level menus. For more
information, see Section 2.4.2, "How to Create and Modify Menus."

The editor type and the node type control whether a menu item is included in the
dynamic top level menu.

When these two conditions are met, the dynamic menu declaratively defined for the
active editor and node opened is displayed as a top level menu. When the extension
user selects this menu, menu item sensitivity is handled by setting the enabled state of
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the action associated with a menu item. For more information, see Section 2.2.1,
"Understanding Rules Based Menu Sensitivity."

2.2.4 Understanding Node Recognizers

Node recognizers are responsible for recognizing the oracle.ide.model .Node
subclass associated with a resource pointed to by a specific URL.

JDeveloper provides two standard recognizers:

= One that can recognize node types such as file extensions, based on information
provided by the URL itself.

= One that can recognize XML node types, based on the content of an XML file.

In previous versions, JDeveloper also allowed custom recognizer implementations to
be registered. This is now deprecated.

The Addin.initialize () method registers a custom implementation of the
oracle.ide.mode.Recognizer class using one of these methods:

m Recognizer.registerRecognizer (String, Recognizer)
m Recognizer.registerRecognizer (String, Recognizer)
m Recognizer.registerLowPriorityRecognizer (Recognizer)

Extensions that provide custom recognizers must adjust their node recognition in such
a way that it can be handled by JDeveloper's recognizers.

If you are rewriting an extension developed for an earlier version of JDeveloper that
used the IDE standard recognizers, you need to remove the recognizer registration
code from the Addin.initialize () method and use the recognizer trigger hook to
register recognition rules in the extension manifest file, extension.xml. For more
information, see Section 1.7, "Working with the Extension Manifest."

2.2.5 Understanding Content Sets

JDeveloper uses content sets to define the categories that are displayed as nodes in the
Application Navigator. The categories in installed JDeveloper include:

= Application Sources
s Web Sources
s Resources

Content sets are registered declaratively, but do not trigger initialization of the
extension that introduced the content set, because content sets require no custom
behavior. You must provide the content set ID, label, and default URLs that indicate
where to look for content in your extension.

Instances of ContentLevelFilter provide client behavior that control what is
shown under a content set.

A ContentLevelFilter is responsible for filtering the breadth-first traversal
implemented by the ContentLevel class to provide a virtual representation of each
level that differs from its physical representation. A ContentLevelFilter may:

= Add new elements to be displayed.
= Remove elements from the display.

= Remove subdirectories from the display.

Developing Extensions in Oracle JDeveloper 2-5



Use Cases for Developing Extensions

= Cause a subdirectory to be displayed even if it is empty.

Instances of ContentLevelFilter are registered statically via the static method
addContentLevelFilter (ContentLevelFilter) inthe class ContentLevel.

After a new application is created or opened in the Application Navigator, if the
extension user expands the top-level folder of a project, before adding all the folders
and files in such project (which uses method open in BaseTreeExplorer) the
method applyContentLevelFilters (Context, List, List) inclass
ContentLevel is called. This method:

1. Gets all the source root directories.

2. Checks that, for each of the instances of ContentLevelFilter registered,
whether a filter can be applied to the given Context. If it can, it calls the method
updateDir (URLPath, String, List, List, Context context) which
can modify the lists of elements and subdirectories for each level before they are
displayed. Whenever there are multiple instances of ContentLevelFilter
applying changes to the same level, later filters will see the effect of earlier filters
and, if appropriate, perform further filtering on them.

3. Does the same as in the previous step for instances of
AsynchronousContentLevelFilter, ContentLevel. It also obtains a
Callable from such a filter, which performs an asynchronous request to get
additional elements.

Note: To find out whether a ContentLevelFilter can be applied to a
Context, ContentLevel retrieves all the content set keys from that
filter and checks to see whether the context has at least one of the keys
as property.

ContentLevelFilter does not need declarative registration. Before filtering takes
place, nodes are created using NodeFactory, which uses recognizers to create nodes
from URLs. Since recognizers are trigger hooks, by the time filtering takes place,
related extensions are already initialized.

In general, extensions that register content level filters also register recognizer rules;
therefore, they are always initialized if a node type is recognized by the recognizer
rules they registered. For example, the Application Navigator ensures that as the user
expands folders in the navigator, it creates instances of nodes for all files found under
that folder, which triggers extension initialization. At that point, JDeveloper invokes
the content level filters giving these a chance to filter out nodes or add other nodes to
display under the folder being expanded.

2.2.6 Understanding Large Extensions

Extensions that provide a wide set of functionality and have a deep dependency tree
are considered large extensions. In general, initializing large extensions causes the
pre-initialization of a number of other extensions due to their deep dependency tree.
In many cases extension users may only be accessing a subset of the wide functionality
provided by a large extension but, inadvertently, they get more than they require due
to the monolithic structure of this type of extension.

To improve the performance of a large extension, it is recommended that you refactor
large extensions following one of these models:

= Identify the extension's main functional areas and refactor prominent areas into
separate extensions; or
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s Keep abstract functional areas in a single extension with a shallow dependency
tree, while moving functional implementation details to separate extensions.

The first model works best when functional areas have simple dependencies between
them. For example, consider an extension, E1, which has two functional areas: X and Y.
A simple dependency means that refactoring extension E1 into extensions E2 and E3
introduces no bi-directional dependencies between E2 and E3, or if it does, these can
be resolved by introducing a support module, (for example, module M1), which
provides the functionality both E2 and E3 need. It is important that M1 not have the
same dependency tree as E1; this defeats the purpose of the refactoring exercise, which
was to reduce the number of extensions that need to be pre-initialized before the
functionality provided by E1 can be exercised. Ideally, extensions E2 and E3 do not
depend on each other and the original dependency tree from extension E1 is now
evenly distributed between extensions E2 and E3.

The second model leaves a version of extension E1 that has a very shallow
dependency tree. In order to reduce the dependency tree, the refactoring operation
must move the implementation of functional areas E2 and E3 to extensions E2impl and
E3impl. For this pattern to work, it is very important that E1 does not depend on
extensions E2impl and/or E3impl. To support this pattern, use the
singleton-service-hook which makes sure that the right implementation, say the
E2impl extension, is initialized when functionality E2 is accessed through extension
El. By using the singleton-service-hook, E2impl is initialized even though E1
does not depend on that extension. For more information, see the section in Singleton
registration in Section 2.5, "How to Define and Use Trigger Hooks."

2.2.7 Understanding Technology Scopes

When the user selects a technology scope, the extension that introduced that
technology scope along with all the other extensions it depends on is initialized. The
deployment dependencies are stated in their projects' deployment profiles. For more
information, see "Deployment Profiles" in Oracle Fusion Middleware User Guide for
Oracle JDeveloper.

If the user’s selection makes it necessary to initialize extensions outside the
dependency tree of the extension introducing the technology scope, the recommended
method of handling this is to wait for the user to use some functional aspect of your
extension that triggers extension initialization. This avoids the concept of the feature
set, which would require initializing all members of the feature set and defeat the
purpose of lazy initialization.

2.3 Getting the JDeveloper Look and Feel

You can develop extensions that blend seamlessly with JDeveloper by following the
guidelines in this section. For example, you can use standard spacing and alignment
for common components by using the UI constants published in the
oracle.javatools.ui.LayoutConstants to achieve the recommended spacing.
The spacing can be used for all components, whether they are in dialogs, wizards or
modeless overview editors.

Figure 2-2 shows the standard spacing used for elements in a JDeveloper dialog.
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Figure 2-2 JDeveloper Dialog Showing Spacing
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Figure 2-3 shows the spacing used for an overview editor in JDeveloper.

Figure 2-3 Overview Editor Showing Spacing
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2.4 How to Create JDeveloper Elements

This section describes how to work with and develop various JDeveloper elements:

Menus

Windows and views

Wizards that can be invoked from the New Gallery or from the Tools menu
JDeveloper commands

Source editors

Explorers

File types

Component palettes

JDeveloper preferences

Making changes undoable

2.41 How to Quickly Create JDeveloper Elements

There are some JDeveloper elements that you can create quickly from the New Gallery:

Actions, that is operations that the extension user may invoke in the IDE. For more
information about Actions, see Section 2.4.5.3, "How to Define an Action.”

Addins, which can perform programmatic initialization and registration for an
extension while JDeveloper is starting up. For more information about Addins, see
Section 2.4.5.1, "How to Implement the Addin Interface."

Data models, which subclass HashStructureAdapter to store the persistent data
model for preferences or project properties. For more information about data
models, see Section 2.4.9.2, "How to Implement the Data Model."

Wizards that can be invoked from the New Gallery or Tools menu. For more
information about wizards, see Section 2.4.4, "How to Develop Wizards."

New panels in the Preferences dialog. For more information about working with
the Preferences dialog, see Section 2.4.9, "Understanding Preferences."

New panels in the Project Properties dialog. For more information about project
properties, see Section 2.4.10, "Understanding Project Properties."

To quickly create a JDeveloper element from the New Gallery:

1.

Follow the steps in Section 1.6.1, "How to Create an Application and Project for
Extension Development" to create an application and extension project.

Open the New Gallery by choosing File > New.

In the New Gallery, in the Categories tree, under Client Tier select Extension
Development.

In the Items list, double-click the JDeveloper element you want to create. The
appropriate dialog opens. For more help, press F1 or click Help from the dialog.

2.4.2 How to Create and Modify Menus

Because so much of a user's interaction with JDeveloper is through the menus,
JDeveloper lets you modify existing menus and create new ones. In addition to adding
selections to the items in JDeveloper's menu bar, you can also add context menus that
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give you finer control over user interactions with the functions provided by your
extension.

Menus interact with the command extension, which in turn relies on the Addin
interface. For more information, see Section 2.4.5, "How to Develop Commands."

2.4.2.1 Understanding Menus

Menus are an important way to integrate your extension's functionality into
JDeveloper. You may wish to add a major feature—selecting a versioning system, for
example, or accessing an internal code-snippet database—to JDeveloper's menu
system, so that your extension can be accessed or controlled through a selection from
the menu or tool bar. On the other hand, some features of your extension—checking
out a file from your organization's versioning software or verifying code with your
organization's preferred tool—might best be handled through a context menu that
pops up when the user clicks the right mouse button in the appropriate place.
JDeveloper's extension system lets you do both. For more information, see

Section 2.4.2.2, "How to Create a Context Menu."

JDeveloper includes a class to support the declarative creation of context menus,
which can then be hooked to the main JDeveloper functionality by a series of listeners
and controllers. This lets you create menu-based extensions that fit within the
structure and user interface of JDeveloper, while adding features and capabilities
beyond the basic IDE. For more information, see Section 2.4.5.5, "How to Invoke an
Addin From a Context Menu."

Alternatively, your extension might have features that already fit within the existing
menu structure of JDeveloper, but add unique functions to each of the current menus.
In this case, your extension needs to add specific new options to existing menus. For
more information, see Section 2.4.2.4, "How to Add Menu Items to an Existing
JDeveloper Menu."

You can also use a similar technique to add new selections to a toolbar. For more
information, see Section 2.4.2.5, "How to Add a Drop-down Button to a Toolbar."

2.4.2.2 How to Create a Context Menu

Creating a menu declaratively using the context menu listener classes lets you use
standard classes. This helps make your extension easy to update, adds consistency
across all menus, helps your extension load quickly, and can require no custom code to
develop. You can use the existing context menu listener classes, by registering them,
using the callback interface that lets you add menus to your extension, and finally by
using the controller associated with the specific view for which the menu is created.
For more information, see Section 2.4.5.5, "How to Invoke an Addin From a Context
Menu."

To create a menu with several selections:

1. Register the context menu listener classes in your extension manifest using the
sample code in Example 2-1.

Example 2-1 Registering Context Menu Listener Classes

<extension xmlns="http://jcp.org/jsr/198/extension-manifest" ...>
<hooks>
<jdeveloper-hook xmlns="http://xmlns.oracle.com/jdeveloper/1013/extension">
<actions>
<!-- Action to show the File List -->

<action id="MY_CMD_ID">
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<properties>
<property name="Name">My Action</property>
</properties>
<controller-class>oracle.ide.extsamples.basic.SimpleController
</controller-class>
</action>
</actions>
<context-menu-listeners>
<site idref="navigator"> <!-- or "editor", or "explorer" -->
<listener-class>oracle.ide.extsamples.basic.
SimpleContextMenuListener</listener-class>
</site>
</context-menu-listeners>
</jdeveloper-hook>
</hooks>

</extension>
2, Implement ContextMenuListener, as shown in Example 2-2.

This is the callback interface that allows extensions to add menu items and
submenus to the context menu:

Example 2-2 ContextMenuListener

package oracle.ide.extsamples.basic;
import oracle.ide.Context;
import oracle.ide.controller.ContextMenu;
import oracle.ide.controller.ContextMenuListener;
import oracle.ide.controller.IdeAction;
/**
* ContextMenuListeners add items to context menus.
*/
public final class SimpleContextMenulistener
implements ContextMenulListener
{
public void menuWillShow (ContextMenu contextMenu)
{
// Add my menu to the context menu only when user clicked on SomeNode class.
if (contextMenu.getContext ().getNode() instanceof
oracle.ide.extsamples.basic.SomeNode.class)
{
IdeAction action = IdeAction.find( SimpleController.SAMPLE_CMD_ID );
contextMenu.add( contextMenu.createMenultem( action ) );

}

public void menuWillHide (ContextMenu contextMenu)

{
// Most context menu listeners will do nothing in this method. In
// particular, you should *not* remove menu items in this method.

}

public boolean handleDefaultAction(Context context)

{
// You can implement this method if you want to handle the default
// action (usually double click) for some context.
return false;

3. Implement oracle.ide.controller.Controller, as shown in Example 2-3.
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Each View has an associated Controller. Controllers receive requests to handle
the commands associated with user actions. The controller's handleEvent method
gets called with the appropriate Command specified. If the Controller does not
handle the requested command, it delegates the Command to a supervising
Controller. Controllers are also responsible for determining the availability of a
specific command, by calling the update method.

Example 2-3 oracle.ide.controller.Controller

package oracle.ide.extsamples.basic;
import oracle.ide.Context;
import oracle.ide.controller.Controller;
import oracle.ide.controller.IdeAction;
/**
* ContextMenulListeners add items to context menus.
*/
public final class SimpleController
implements Controller
{
public static final int MY _CMD_ID = Ide.findCmdID( "MY_CMD_ID" );
public boolean handleEvent ( IdeAction action, Context context )
{
if (IdeAction.getCommandId() == MY_CMD_ID )

// Do some action
return true;
}

return false;

}

public boolean update( IdeAction action, Context context )
{
if (IdeAction.getCommandId() == MY _CMD_ID )
{
// Enable action
action.setEnabled(true) ;
return true;

}
action.setEnabled(false);
return false;

}

2.4.2.3 How to Improve Performance by Registering a Context Menu Listener
Registering a context menu listener makes sure your context menus pop up quickly.

Context menu listeners should do the minimum amount of work so that they do not
delay the popping-up of context menus. Currently, there are close to 250 menu
listeners for the Application Navigator context menu, therefore, on average listeners
have to take less than 4 milliseconds for the context menu to pop up in less than a
second.

Here are some tips for improving performance:

= If your extension is interested in certain nodes only, your context menu listeners
should be registered for that specific node type. This guarantees that your listener
is only called when the user of your extension clicks on a node of that type.
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= When your listener's menuWillShow method is called, your only action should be
to add your menu item. Protect against non-applicable contexts when your menu
item action is executed.

= Your listener's menuwWillHide method should do nothing.

The following things have a negative impact on context-menu performance:
= FileI/O operations.

= Parsing the contents of files.

= Iterating over a list of things looking for something.

= Searching for something on the file system.

s [terating over the menus already added to the context menu and trying to rename
them or remove them.

2.4.2.4 How to Add Menu ltems to an Existing JDeveloper Menu

Sometimes, a feature of your extension can be handled simply by adding an item, or a
group of items, to an existing JDeveloper menu or toolbar. For more information, see
Section 2.4.5.4, "How to Invoke an Addin From a Main Window Menu."

To add a new menu item to the Tools menu:

1. Importoracle.ide.controller. *, then create the action (_myActionID) you
plan to call in the menu, as shown in Example 2—4.

Example 2—4 oracle.ide.controller.*

import oracle.ide.controller.*;

// Create the action

_myActionID = Ide.createCmdID("FirstAction");

IdeAction firstAction = IdeAction.get(
_myActionID,
null,
"My First Action",
IdeMainWindow.ACTION_CATEGORY_TOOLS,
new Integer('F'),
null, null, true);

2. Set the current item as the controller:, as shown in Example 2-5.

Example 2-5 Controller

// Set ourselves as the controller
firstAction.addController (this) ;

3. Add the menu item associated with firstAction to the menu, as shown in
Example 2-6.

Example 2—6 firstAction Menu Item

// Add a menu entry in the Tools menu
final Menubar menubar = Ide.getMenubar () ;
final JMenultem firstActionMenu = menubar.createMenultem
firstAction, MenuConstants.WEIGHT UNDEFINED) ;
menubar.add
(firstActionMenu, MenuManager.getJMenu (IdeMainWindow.MENU_TOOLS) ) ;
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To add multiple menu items to an existing menu:
Example 2-7 adds three menu items to an existing menu.

Example 2-7 Sample Code to Add Three Menu Items to Menu

// First menu of the first section
JMenulItem menul = contextMenu.createMenultem(myActionl, 1f);
contextMenu.add (menul, 1f);

// Second menu of the first section
final JMenultem menu2 = contextMenu.createMenultem(myAction2, 2f);
contextMenu.add (menu2, 1f);

// <- First menu of the second section
final JMenuItem menu3 = contextMenu.createMenultem(menu3, 1f);
contextMenu.add (menu3, 2f);

2.4.2.5 How to Add a Drop-down Button to a Toolbar

In some cases, your extension will operate through a window which may itself have a
toolbar with specific options unique to your extension, or to the specific data object
viewed in your extension's window. For more information, see Section 2.4.5.4, "How to
Invoke an Addin From a Main Window Menu."

To add a drop-down button to a toolbar:

The code in Example 2-8, when included as a method to a window unique to your
extension, adds a drop-down button, with three actions, to a toolbar. When the user
clicks the button, the menu that appears contains three actions.

Example 2-8 Adding a Drop-down Button to a Toolbar

void doit(Toolbar toolbar, IdeAction dropDownIdeAction, IdeAction ideActionl,
IdeAction ideAction2, IdeAction ideAction3) {
ActionMenuToolButton actionMenuToolButton =
toolbar.addActionMenuButton (dropDownIdeAction) ;
Action[] actions = new Action[] {
ideActionl,
ideAction2,
ideAction3,
I
actionMenuToolButton.setMenuActions (actions) ;

2.4.3 Working with Windows and Views

The JDeveloper data model uses two important concepts for displaying and
monitoring the content of the information you are working with: windows and views.
Windows (often dockable windows, which occupy a specific location in the IDE
framework) display information and take command inputs. Views define how
JDeveloper accesses the information objects (such as files or database records) that
your extension generates, manipulates or displays.

2.4.3.1 Understanding Dockable Windows

Dockable windows allow you to create a dedicated area for your extension at a
specified location in JDeveloper. Using dockable windows involves two key steps:
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1. Creating a dockable window.
2. DPositioning a dockable window.

Once you have created and positioned the window to be used by your extension, you
need to make sure that your extension is aware of that window, and in particular, that
it is aware when the user has selected your window for input. The mechanism that
JDeveloper uses for this is the IDE listener. Adding an IDE listener to your window
connects your extension to the window you created. For more information, see
Section 2.4.3.4, "How to Add an IDE Listener to a View."

Now that you have created, positioned, and assigned an IDE listener to your dockable
window, you are ready to make sure that your extension is aware when the user has
selected it. When a window is selected, it has the active view. You can now instruct the
IDE listener you added to listen for the active view. For more information, see

Section 2.4.3.5, "How to Listen for the Active View."

2.4.3.2 How to Create Simple Dockable Windows

Creating a dockable window involves three steps: creating a DockableFactory,
creating a dockable window using the class MyDockableWindow, and then installing
the DockableFactory during the addin initialization.

To create a dockable window:
1. Create a DockableFactory, as shown in Example 2-9.

Example 2-9 DockableFactory

public class MyDockableFactory implements DockableFactory
{
static final String VIEW_TYPE = "MY VIEW_TYPE";
public void install()
{
final DockingParam dockingParam = new DockingParam() ;
dockingParam.setPosition (IdeConstants.SOUTH) ;
DockStation.getDockStation () .dock (
new MyDockableWindow(),
dockingParam) ;
}
public Dockable getDockable (ViewId viewId)
{
if (viewId.getName () .equals (MyDockableWindow.VIEW_ID))
return new MyDockableWindow() ;
{

return null;

2. Create a DockableWindow, as shown in Example 2-10.

Example 2-10 DockableWindow

public class MyDockableWindow extends DockableWindow
{
static final String VIEW_ID = "MY VIEW_ID";
private JLabel _ui;
public MyDockableWindow ()

{
super (MyDockableFactory.VIEW_TYPE + "." + VIEW_ID);
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public String getTabName ()
{
return "ShortName";
}
public String getTitleName ()
{
return "The Long Name Comes Here";
}
public String getTitleName ()
{
return "The Long Name Comes Here";
}
public Component getGUI ()
{
if (_uil == null)
{
_ul = new JLabel ("The UI is here");
}
return _ui;
}
public int getDefaultVisibility(Layout layout)
{
return DEFAULT VISIBILITY VISIBLE;

3. Install the factory during the addin initialization, as shown in Example 2-11.

Example 2-11 Install Factory

DockStation.getDockStation() .registerDockableFactory (
MyDockableFactory.VIEW _TYPE,
new MyDockableFactory ()

)i

2.4.3.3 How to Position Dockable Windows

Example 2-12 shows how to center a dockable window with the Application
Navigator. If the application navigator extension is not loaded, the window will be
docked on the left (WEST).

Example 2-12 Centering a Dockable Window

dockingParam = new DockingParam() ;
final NavigatorManager applicationNavigatorManager =
NavigatorManager.getApplicationNavigatorManager () ;
final NavigatorWindow navigatorWindow =
applicationNavigatorManager.getNavigatorWindow() ;
dockingParam.setPosition (

navigatorWindow,

IdeConstants.CENTER,

IdeConstants.WEST
)i

2.4.3.4 How to Add an IDE Listener to a View

To add a selection listener to the active view, you need to listen for the active view
changes. If you added your listener to the view becoming inactive, you need to remove
your listener from that view.
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To add an active listener:
Create code based on Example 2-13.

Example 2-13 Adding an Active Listener

import oracle.ide.view.ActiveViewListener;

import oracle.ide.view.ActiveViewEvent;

import oracle.ide.view.ViewSelectionListener;

class MyActiveViewListener implements ActiveViewListener
{

private ViewSelectionListener _selectionListener = new ViewSelectionListener ()
{
public void viewSelectionChanged (ViewSelectionEvent e)
{
//Your code responding to view selection changes goes here.
{
}i

To change the active listener:
Create code based on Example 2-14.

Example 2-14 Changing an Active Listener

public void activeViewChanged (ActiveViewEvent e)
{

View view = e.getOldView();

if (view != null) view.removeViewListener (_selectionListener);

view = e.getNewView();

//While this example adds a ViewSelectionListener to any active view,
//it 1s strongly recommended that you add your view selection listener
//to views your extension is interested in only.

view.addViewListener (_selectionListener) ;

2.4.3.5 How to Listen for the Active View

The JDeveloper IDE architecture’s model/view /controller model requires that your
extension keep track of which view—that is, which representation of the data is being
displayed in a given window—is active. (You may be familiar with windowing
systems that refer to active views as having input focus.) The JDeveloper IDE
architecture requires your extension to listen for the active view, as a way of ensuring
that commands executed by the view are applied to the appropriate data.

To listen for the active view:
Create code based onExample 2-15.

Example 2-15 Listening for the Active View

Ide.getMainWindow () .addActiveViewListener (new ActiveViewListener ()
{

public void activeViewChanged (ActiveViewEvent e)

{
final View view = e.getNewView();
System.out.println(view.getId() + " has been activated");
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2.4.4 How to Develop Wizards

A wizard is an extension that is invoked to perform some task. A typical wizard is
invoked through the Ul to open a user interface consisting of one or a sequence of
dialog boxes, in which the user specifies task parameters. A typical task is the creation
of a document or other data object. Specialized invocation mechanisms are provided
for wizards that are installed in the New Gallery or the Tools menu. In these cases the
Wizard Manager manages the invocation details.

2.4.4.1 How to Set Up a Wizard Project

The wizard project's properties specify paths, libraries, and other settings for the
wizard project. When you have set up your project you can add your source files to it,
and then debug and deploy your wizard.

A wizard project usually has three main components:

= A wizard class. This class deals with the wizard's appearance in the user interface,
and with its invocation. This class must implement the Wizard interface.

= A modal dialog. The dialog interacts with the user to collect data required for the
function of the wizard.

= A data object. The wizard applies the data collected by the dialog to create or
modify a data object.

The code examples shown in this section are taken from the Hel1loX sample project,
available as part of the Extension SDK. For more information, see Chapter 3,
"Developing with the Extension SDK.".

HelloX implements wizard directly, and uses a JDialog as its user interface. Wizards
that conform to JDeveloper's look and feel use the JEWT wizard framework.

2.4.4.2 How to Implement the Wizard Interface

Extensions that are to be invoked from the user interface to perform some modal task
should implement the oracle.ide.wizard.Wizard interface. This interface
provides for the extension's installation, and integrates it with JDeveloper's user
interface.

To Implement the wizard interface:

= Define the constructor

»  Define the invoke method

s Define the getMenuSpecification method

s Define the isAvailable method

s Define the getIcon method

s Define the getName method

24.4.2.1 How to Define the Constructor A wizard's constructor is invoked only once,
when the wizard is loaded. The constructor should be lightweight, meaning that it

should not create and hold object references, and you should defer such operations to
the initialize method.
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24.4.22 How to Define the Invoke Method This method embodies the wizard's
functionality. Wizards generally open a dialog to obtain parameters from the user, and
then use those parameters to create or modify a document or other data object.

This method is called when the wizard's Ul element is selected by the user through the
New Gallery or Tools menu. The context parameter identifies the currently selected
objects that the wizard might affect. The params parameter is empty when the wizard
is called from Tools menu, and contains the value set of the wizard's
wizardParameters tag from the extension.xml file.

To define the invoke method:
Create code based on Example 2-16.

Example 2-16 Defining the Invoke Method

public boolean invoke(oracle.ide.addin.Context context, java.lang.String[] params)
{
if ( !this.isAvailable(context) )
return false;
String greetee = null;
JProject project = (JProject) context.getProject();
// Get the parameter from the user.
greetee = JOptionPane.showInputDialog
(new JDialog (), prompt, wizName, JOptionPane.OK_CANCEL_OPTION) ;
if ( greetee == null )
return false;
// Create the document and the node that represents it.
if ( !createNode (project, greetee) )
return false;
return true;

2.4.4.2.3 How to Define the getMenuSpecification Method This method is called to
determine the appearance of the wizard's item in the Tools menu, when it is to be
displayed. If the wizard is not installed in the Tools menu this method should return
null.

To define the getMethodSpecification method:
Create code based on Example 2-17.

Example 2-17 Defining the getMethodSpecification Method

public MenuSpec getMenuSpecification()
{
if ( menuSpec == null)
{
Icon icon = getIcon();
menuSpec = new MenuSpec (wizName, new Integer((int)'X'), (KeyStroke)null,
icon);
}

return menuSpec;

}

24.4.24 How to Define the isAvailable Method This method is called to determine if the
wizard's New Gallery entry or Tools menu item should be enabled or disabled, given
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the current context. For example, a wizard that operates on project nodes must only be
enabled only when the current node is a project node.

To define the isAvailable method:
Create code based on Example 2-18.

Example 2-18 Defining the isAvailable Method

public boolean isAvailable(oracle.ide.addin.Context context)
{
Project p = context.getProject();
if ( (p !'= null) && (p instanceof JProject) )
return true;
return false;

2.4.42.5 How to Define the getlcon Method This method is called to obtain the wizard's
New Gallery or Tools menu icon. If the wizard does not require an icon, this method
should return null.

To define the geticon method:
Create code based on Example 2-18.

Example 2-19 Defining the getlcon Method

public Icon getIcon()
{
if (image == null)
{
image = GraphicsUtils.createImageIcon (
GraphicsUtils.loadFromResource (imageName, this.getClass()));
}
return image;

}

24.4.2.6 How to Define the getName Method This method provides a human-readable
name for the wizard, so enter an appropriate string.

2.4.4.3 How to Add a Wizard to the New Gallery

Wizards can be installed in the New Gallery by including a gallery wizard description
for them in the extension manifest file. All of the details of wizard registration and
event processing are handled by the Wizard Manager.

If the wizard is to be invoked only from the New Gallery, the constructor for the
wizard class is not called until the extension user first opens its category. The Gallery
Manager reads the description file when the category is first opened, and then
instantiates the wizard and constructs the item using the icon and label derived from
the instance.

2.4.4.4 How to Add a Wizard to the Tools Menu

The Wizard Manager provides special support for wizards that are installed in the
Tools menu. The Wizard Manager takes care of the details of adding the menu item
and handling the user's selection of it.
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Wizards can also be installed elsewhere in the user interface, such as other menu,
context menus, or the tool bar, but in these cases a command must be defined, and
installed and handled explicitly. In the extension manifest file, include an addin
description for the wizard.

To install a wizard in the Tools menu:

1. Your wizard should implement getMenuSpecification (), as shownin
Example 2-20. In this method, create a new instance of
oracle.ide.util.MenuSpec, passing in the label, mnemonic, and icon of the
required menu item.

The code example is taken from the HelloX and ConfigPanel sample project,
available as part of the Extension SDK. For more information, see Chapter 3,
"Developing with the Extension SDK.".

Example 2-20 Installing a Wizard in the Tools Menu

public MenuSpec getMenuSpecification()
{
if ( menuSpec == null)
{
Icon icon = getIcon();
menuSpec = new MenuSpec (wizName, new Integer ((int)'X'),
(KeyStroke)null, icon);
}

return menuSpec;

}

2. Define the wizard's getMenuSpecification method to return an icon and
label. (This method may return null if the wizard is invoked only from the New
Gallery).

3. Deploy the extension to install it. For more information, see Chapter 5, "Packaging
and Deploying Extensions."

2.4.5 How to Develop Commands

An extension that adds a user-interface element such as menu item or toolbar icon, or
customizes an existing element for a new purpose, should encapsulate the
functionality in a command extension.

2.4.5.1 How to Implement the Addin Interface

Most extensions should implement the Addin interface. This interface provides for the
extensions installation at the time of JDeveloper's startup.

To implement the Addin interface, first define the constructor. The constructor should
do as little as possible; defer initialization tasks to the initialize method.

Then, define the initialize method. This method is called by the Addin Manager
after the instance has been created. The tasks that should be performed at initialization
are:

s creation of Ul elements and controllers.
= Registration with managers.

Other tasks, such as the creation of data structures that are not needed until and if the
addin is invoked, should be deferred, so that JDeveloper's startup is not unnecessarily
delayed.
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2.4.5.2 How to Implement a Command

If your extension adds a menu item or toolbar icon, you should implement its
functionality as a command.

An extension that defines specialized behavior for an existing control should use the
action and command class already provided for it, rather than define a custom action
or implement a custom command class. Fields defined in the Ide class give the class
names and IDs of the IDE's standard commands.

A command for an extension involves these tasks:
» Handling the event

= Defining the undo method

= Defining other methods

The code examples in this section are taken from the FirstSample sample project,
available as part of the Extension SDK. For more information, see Chapter 3,
"Developing with the Extension SDK.".

24.5.21 Handling the Event The code in Example 2-21 shows how to handle the event,
which is triggered when you invoke the command.

Example 2-21 Handling the Event
/ * %
* ContextMenuListeners add items to context menus.
*/
public final class SimpleContextMenuListener implements ContextMenuListener {
public void menuWillShow(ContextMenu contextMenu) {
// First, retrieve our action using the ID we specified in the
// extension manifest.
IdeAction action = IdeAction.find(SimpleController.SAMPLE_CMD_ID);
// Then add it to the context menu.
contextMenu.add (contextMenu.createMenultem(action));
}
public boolean handleDefaultAction(Context context) {
// You can implement this method if you want to handle the default
// action (usually double click) for some context.
return false;

}

For long blocks of code, you can use the doIt method.

24522 How to Define the undo Method This method must be defined only if the
constructor specifies that the controller is of the NORMAL type. The undo method
generally has two tasks:

= Undo the doit methods effect by restoring a checkpointed state with the value
obtained from the getData method, or by performing the inverse of the doit
method's operation.

= Notify observers that the modification has taken place.
Return OK if the command is successful, or CANCEL or some other non-zero value if

not. The default implementation returns CANCEL and has no side-effects.

24.5.2.3 How to Define Other Methods These methods' default implementations can be
overridden:
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= getIdreturns the command ID passed to the constructor.

= getType returns the "command type" constant passed to the constructor, or NO_
CHANGE if this argument was not given.

= getName returns the name string passed to the constructor, or the empty string if
this argument was not given.

s getAffectedNodes returns null by default.

s setContext and getContext respectively write and read a protected Context
variable. The default value is null.

s setData and getData respectively write and read a private Object variable.
The default value is null.

2.4.5.3 How to Define an Action

An extension that implements new command classes should define actions to contain
them. An action serves as the link between a menu item, or other user-interface
control, and the command that is executed when the menu item is selected. Actions are
instances of IdeAction.

An extension that defines specialized behavior for an existing Ul element should use
the action already provided for it, rather than define a custom action. Fields defined in
the Ide class give the class names and IDs of the standard commands. For example,
any editor that provides a 'save' operation should use the predefined Ide.SAVE_CMD
and Ide.CUT_SAVE_ID values and the action that is associated with them.

Actions are typically defined as fields of the Addin class that installs the menu items
or toolbar icons they are associated with. Create and configure actions as part of the
extension's initialization.

The code examples in this section are taken from the FirstSample sample project,
available as part of the Extension SDK. For more information, see Chapter 3,
"Developing with the Extension SDK.".

2.45.3.1 How to Obtain an Action Actions are cached by command ID. If an action
already exists for the command you require, you should generally use it instead of
creating a new one.

Do not use the TdeAction contstructors to create actions. Instead, use the following
static methods to retrieve a cached action or create a new one:

s The find method returns an action that contains the given command id, if one has
already been cached.

s The various get methods return the action matching the given command id, if
such an action has been cached, but the properties of this action may or may not
match the parameters given. If no action is found for the command ID a new
action is created from the given parameters, cached, and returned.

s The create methods create and return a new action without caching it. A action
obtained from create is not available to subsequently loaded extensions.

24.5.3.2 How to Set Action Values An action may have various properties, such as those
that determine appearance, which are accessed through string keys by the putValue
and getValue methods. Some of the properties are set when an action is created by a
create or get static method. Keys recognized by the IDE are defined in the
ToggleAction superclass. For more information, see ToggleAction in the Oracle
Fusion Middleware Java API Reference for Oracle Extension SDK.
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24.5.3.3 How to Extend an Action's Controller An action that is independent of a view,
such as 'open’, must specify a controller to update the action and handle its events. An
action that is invoked in the context of a view need not have an action controller.

The behavior of a command, for all IDE features that use that command, can be
extended to perform some custom operation by replacing the controller of the
command's action, or by giving the action a controller if it did not already have one.
However, care must be taken to avoid disrupting default behavior.

To replace an existing controller:
1. Implement the new controller class by extending the old class.

2. In the new controller's handling of the command that is to be extended, perform
the custom operation, and then invoke the old controller's handleEvent method
for the command, so that the original behavior is preserved.

To add a controller to an action that does not have one:
1. Implement a new controller class.

2. In the new controller's handling of the command that is to be extended, perform
the custom operation, and then invoke the supervisor's handleEvent method
for the command, so that the original behavior is preserved.

Use the getController and addController methods to access an action's
controller.

2.4.5.3.4 Extending an Action's Command Class The getCommand method returns the
name of the action's command class. The setCommand method can be used to replace
it. However, doing so replaces it globally, affecting all IDE features that handle the
action. To avoid unwanted side effects, replace an original command class only with a
class that extends it.

2.4.5.4 How to Invoke an Addin From a Main Window Menu

To allow an addin to be invoked from a main window menu, add a menu item for it to
one of the main window menus. The item can be added to any menu, however, if the
extension is to be invoked from the Tools menu, it should be installed as a wizard,
rather than (or in addition to) being installed as an addin: the Wizard Manager takes
care of the details of adding and handling menu item in the Tools menu.

The IDE menus are represented by a singleton instance of Menubar, which can be
accessed using the getMenubar method.

Extensions can add menus, submenus, and menu items to the IDE menus. Extensions
that are invoked, such as wizards, add their own items to menus when they are
installed. Alternatively, extensions can define their own behavior for standard menu
items. For example, effect of the items in the Edit menu depend on the editor in use.

Menu items are associated with IdeAction objects.

When the state of the IDE changes, the enabled /disabled status of all menu items are
reset as dictated by the active view's controller. When the user then selects a menu
item or enters a keyboard shortcut for an item, the command named by the item's
action is executed under the current context.

To define a menu item, provide these components:

= A command ID representing the command that is to be executed when the menu
item is selected.
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s An action that is associated with the command ID, and acts as the link between
user actions and the controller. For more information, see Section 2.4.5.3, "How to
Define an Action."

= A controller responsible for enabling and disabling the menu item and handling
its events, and ultimately invokes the feature installed by the addin. For more
information, see Section 2.4.6.3, "How to Implement a Controller."

s The menu item, which serves as the link between user actions and the controller.

Call the menu bar's createMenuItem method to create the menu item. The menu bar
is a component of the IDE.

return Ide.getMenubar () .createMenultem(action);

Menus are static members of the Main Window. Call a menu's add method to add a
menu item. Menu items should be immediately available when JDeveloper is
launched, so create and install them in the addin's initialize method. The
following adds a menu item to the Navigate menu.

public void addMenuItem()
{
Environment.getJMenu (IdeMainWindow.MENU_EDIT) .
add (createMenuItem(contextInfoAction));

}

2.4.5.5 How to Invoke an Addin From a Context Menu

Some views, such as the Application Navigator and the source editor have context
menus that pop-up when the user right-clicks in the window. Extensions can add
items to context menus.

User interface elements that are represented by objects of any class that implements
ContextMenuListener may have a context menu. Context menus can be used
almost anywhere in JDeveloper: most of the user interface's elements ultimately either
implement this class, or are subcomponents of implementors.

When the user right-clicks, the context menu is reconstructed. Selected context menu
listeners — those associated with the subject of the right-click — are polled, and given
the opportunity to contribute items or submenus to the context menu. For example,
when a node representing a document is right-clicked, editors and designers that are
registered as viewers for that document's type are allowed to add their menu items to
the context menu.

A context menu listener is polled through these methods:

= poppingUp, called when the context menu is being constructed. The listener
should contribute its menu items at this time.

m poppingDown, called when the context menu is dismissed.

» handleDefaultAction, called on double-clicks, in which case exactly one of the
polled listeners should return true, indicating that the action associated with its
menu item should be invoked.

To allow an extension to be invoked from a context menu, add a menu listener to the
view's context menu. The menu listener is given an opportunity to install the menu
item when the context menu is recreated, which occurs whenever it pops-up.

To define a context menu item, provide these components:
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= A command ID representing the command that is to be executed when the menu
item is chosen.

s An action that is associated with the command ID, and acts as the link between
user actions and the controller. For more information, see Section 2.4.5.3, "How to
Define an Action."

= A controller responsible for enabling and disabling the menu item and handling
its events, and ultimately invokes the feature installed by the addin. For more
information, see Section 2.4.6.3, "How to Implement a Controller."

= A context menu listener, which provides a listener instance for each context menu
to which the item can be added. The various views each manage their own context
menus.

Example 2-22 adds a listener to the Application Navigator’s context menu.

Example 2-22 Adding a Listener to Context Window

public void createCtxMenuListeners (ContextInfoController controller) ({
ContextMenu menu;
// Add a listener to the Explorer's context menu.
// This form will work for any manager or view that defines getContextMenu.
menu = EditorManager.getEditorManager () .getContextMenu () ;
menu.addContextMenuListener (new ContextInfoMenuListener (controller));
// Add a listener to the Navigator's context menu.
NavigatorManager.getWorkspaceNavigatorManager () .addContextMenulistener

(new ContextInfoMenulistener (controller), null);

}

The context menu listener should be added when the addin is loaded, so this task
should be performed in the addin's initialize method. The creation of the controller
and action can be deferred until the context menu is opened; the first time it calls the
listener's method.

2.4.6 How to Develop Editors

An editor is a view that displays an object for the user to modify. Editors usually
display text; a designer is a non-textual editor. Editors are opened for a document
through its node's context menu or the View menu. The editors available for a
document are those registered for the document's type with the IDE's Editor Manager.
Editors are usually used in conjunction with structure explorers, but this is not
required.

2.4.6.1 How to Implement the EditorAddin Class

Editor extensions implement the EditorAddin class, which integrates the extension
with the Editor Manager, and provides for the extension’s installation at the time of
JDeveloper's startup.

To implement the EditorAddin class:

= Define the constructor.

s Define the initialize method.

s Define the getEditorClass method.
»  Define the isDefault method.

s Define the getMenuSpecification method.
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The code examples shown here are taken from the CustomEditor sample project,
available as part of the Extension SDK. For more information, see Chapter 3,
"Developing with the Extension SDK.".

2.4.6.1.1 How to Define the Constructor The constructor should do as little as possible.
Defer initialization tasks to the initialize method.

24.6.1.2 How to Define the initialize Method This method is called by the Addin Manager
after the instance has been created. Register the editor with the Editor Manager here.

Editors must be registered with the IDE's EditorManager. A registration associates an
editor with one or more node classes. When the user attempts to open an editor for a
node, through either its context menu or the View menu, only editors that are
registered for that node's class are enabled.

2.4.6.1.3 How to Define the getEditorClass Method This method names the class, an
implementation of Editor which acts as the editable view.

2.4.6.1.4 How to Define the isDefault Method A node class can have a default editor; when
the user double-clicks on the node it is opened in the default editor. To declare an
editor to be the default for its registered node types, implement this method to return
true.

2.4.6.1.5 How to Define the getMenuSpecification Method The Editor Manager adds the
menu specification for the icon and text which appear at the top of each navigator,
identifying it. The menu specification describes the appearance of the editors menu
item.

2.4.6.2 How to Define an Editor Class

An editor is a view that displays an object for the user to modify. Create your own
editor by extending Editor. The editor class is instantiated whenever a node of a type
registered for the editor is opened for viewing.

An editor is associated with these other components:

s The Editor Manager, a component of the IDE, selects an editor class and
instantiates it when the user opens a node.

= AnEditorAddin serves as the go-between the editor and the Editor Manager.
When JDeveloper starts, the addin registers the editor class.

An object representing the data being edited, usually an implementation of Node.

= An editor component, an implementation of JEditorPane, which performs the
actual modification of the data.

= A Controller thatinterprets user interface editing commands and invokes
editor component methods.

= An Explorer that displays the structure of the data object. The explorer responds
to user actions by calling editor methods.

An editor class must be responsible for:
» Instantiating the editor

s Initializing the editor

= Accessing the Controller

»  Getting the root GUI component
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= Responding to explorer events
= Responding to editor component events
= Generating update messages

The code examples shown here are taken from the CustomEditor sample project,
available as part of the Extension SDK. For more information, see Chapter 3,
"Developing with the Extension SDK.".

24.6.21 How to Instantiate the Editor The Editor Manager instantiates an editor class
when the user opens a node in the Application Navigator. The Editor Manager calls
the default constructor, so no context-specific parameters are available to it, as shown
in Example 2-23.

Example 2-23 Editor Manager Calling the Default Constructor

public PropFileEditor ()

{
systemClipboard = Toolkit.getDefaultToolkit().getSystemClipboard();

24.6.2.2 How to Initialize the Editor The Editor Manager initializes a editor instance by
calling its setContext method. This method should extract the document to be edited
from the context, and initialize the editor component, as shown in Example 2-24.

Example 2-24 Initializing the Editor Component

public synchronized void setContext( Context context )
{
if ( context != null )
{
Element element = context.getElement();
// A sanity check: if the context is bad the editor pane will be empty.
if ( ( element != null ) &&
( element instanceof TextDocument ) )
{
super.setContext ( context );
document = (TextDocument) context.getElement();
initializeGraphics( context );

)

2.4.6.2.3 How to Access the Controller The editor has an associated controller instance
that intercepts and interprets user events. The IDE calls the editor's getController
method to acquire the controller, which should create the controller when first called,
as shown in Example 2-25.

Example 2-25 Calling the Editor’s getController Method

public Controller getController()
{

if ( editorController == null )
editorController = new PropFileEditorController( this );

}

return editorController;
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24.6.24 How to Get the Root GUI Component The editor has an associated root graphical
user interface component, and return the panel for this editor instance, as shown in
Example 2-26.

Example 2-26 Getting the rootGUI component

public Component getGUI ()
{

return mainPanel;

}

2.4.6.25 How to Respond to Explorer Events An explorer view of a data object provides a
means of navigating in a document in an editor: when the user selects an element in
the explorer, the explorer instructs the editor to display the corresponding part of the
data.

If the editor is intended to be integrated with an explorer it must provide one or more
'goto’ methods. (This capability is not required by the Editor interface.) Example 2-27
is a method that causes the editor's cursor to move to a specified line of a text file.

Example 2-27 Method that Moves Cursor

public void setCaretPosition( int offset )
{
editorComponent.setCaretPosition( offset );

}

24.6.26 How to Respond to Editor Component Events The editor component, as an
implementation of JEditorPane, generates action events when its data changes. The
editor should implement an interface such as KeyListener, and during initialization
should call the editor component's addkeyListener method to register itself to
receive the events. Example 2-28 contains an example of the KeyListener method
keyTyped triggers a method that alerts other IDE objects, such as the recognizer, of
the change.

Example 2-28 KeyListener Method

public void keyTyped( KeyEvent e )
{
timer.restart();

}

2.4.6.2.7 How to Generate Update Messages When the data object's state changes other
IDE components — such as the document's explorer — must be informed. This is
accomplished through the notification mechanism. The editor creates an
UpdateMessage instance and broadcasts it to the document's observers, as shown in
Example 2-29.

Example 2-29 UpdateMessage Instance

public void keyTyped( KeyEvent e )
{

timer.restart();
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2.4.6.3 How to Implement a Controller

If your extension implements a view c